# TABLE OF CONTENTS

1. Introduction .............................................................................................. 1

2. Operation ................................................................................................... 2
   2.1 Configuring .......................................................................................... 2
   2.2 Taking Measurements ........................................................................ 4
      2.2.1 Measurement Tips ....................................................................... 5
      2.2.2 Manual Measurements ................................................................ 7
      2.2.3 Log Mode Measurements ............................................................... 8
   2.3 Saving and Annotating Readings ......................................................... 9
   2.4 Viewing Data ....................................................................................... 10
   2.5 Downloading Data ............................................................................... 11
   2.6 Erasing Data ....................................................................................... 13

3. System ....................................................................................................... 14
   3.1 Specifications ....................................................................................... 14
   3.2 Components ......................................................................................... 15
      3.2.1 Probe ......................................................................................... 16
      3.2.2 External PAR Sensor ................................................................. 16
      3.2.3 Keypad ....................................................................................... 17
      3.2.4 Display ....................................................................................... 17
   3.3 LP-80 Utility ......................................................................................... 22
   3.4 Theory .................................................................................................. 24
      3.4.1 Average and Intercepted PAR .................................................... 24
      3.4.2 Sampling for Fractional Interception ......................................... 25
      3.4.3 Using PAR to Determine Leaf Area Index .................................. 27
      3.4.4 Extinction Coefficient and Canopy Structure ............................ 29
About 22
Active Segments 21
Annotate 10
Calibration 20
Configuration 2, 19–22
contrast 21
Data 10, 19
Date 3, 20
Detailed Data 11
External Sensor Constant 20
Leaf Distribution 20
Location 3, 20
Log 9, 18–19
PAR 5, 18
Save Method 9
Time 4, 20
View Data 10
specifications
measurement 14
physical 14–15
spectral response 47

T
tau (τ) 5, 47
terms and conditions 44
theory 24–36
canopy distribution 32–33
extinction coefficient 29
fractional interception 25–27
intercepted PAR 24–25, 27–28
PAR corrected for z 31–32
z and Equation of Time 34–36
troubleshooting 42–43

Z
zenith angle (z) 5, 29–30, 34, 47–48
**INDEX**

**B**
- battery icon 39
- replacement 39–41
- type 15

**C**
- cable 1, 15, 16
- calibration 37–39
- cleaning 41
- compliance 15
- components
  - display 17–21
  - keypad 17
  - probe 6, 16
  - shipped 1
- configuration
  - date 3
  - daylight saving time 3, 20
  - location 2–3
  - power noise filter 21
  - time 3–4
  - customer support 43

**D**
- data
  - annotate 9
  - download 11–12
  - erase 13–14
  - file types 11
  - save 9–10
  - storage 15
  - view 10–11, 19

**E**
- Equation of Time 34
- external PAR sensor 15, 16, 20, 46
- fractional beam radiation (Fb) 5, 46
- leaf area index (LAI) 4, 5, 20, 46
- leaf distribution parameter (χ) 5, 29, 46–47
- LP-80 Utility
  - Actions menu 23
  - download data 11–12
  - Edit Menu 22–23
  - erase data 13
  - File menu 22
  - Help menu 23
  - installation 22
  - Preferences window 22
  - update LP-80 firmware 24
- USB 1

**F**
- measurement
  - above canopy 7
  - below canopy 7
  - logging mode 5
  - manual 5, 7–8
  - row crops 6–7

**P**
- photosynthetically active radiation (PAR) 1, 24–25, 47

**R**
- references 45
- repair 41

**S**
- sample size 6
- screen
calculated by the LP-80 based on the global position and the time of day and is displayed in the lower right corner of the screen when taking PAR measurements. To make sure this value is accurate, the longitude, latitude, date, and time of day must be set correctly.

1. INTRODUCTION

Thank you for choosing the ACCUPAR LP-80 PAR/LAI Ceptometer from METER Group. The LP-80 measures photosynthetically active radiation (PAR) and can use these readings in a model to give a leaf area index (LAI) for a plant canopy. This manual includes instructions for setting up the LP-80, verifying the calibration of the instrument, preparing samples, and maintaining and caring for the instrument.

The LP-80 and its accessories arrive in a durable foam-padded carrying case. Verify all LP-80 components are included and appear in good condition:
- ACCUPAR LP-80
- External PAR sensor
- 5-pin to RS-232 cable
- USB adapter cable
- USB drive with LP-80 Utility (attached to manual cover)
- #1 Phillips screwdriver

The LP-80 was shipped without batteries to preserve battery life and prevent damage to the instrument. Install the included four AAA batteries in the LP-80 and securely attach with washers and screws prior to use (Section 4.2.1).
2. OPERATION
Please read all instructions before operating the LP-80 to ensure it performs to its full potential.

Please observe the following considerations carefully:
• Keep the probe clean. Measurement accuracy may decline if debris on the probe prevents light from entering the sensors.
• Do not immerse the instrument in water or leave it in contact with rain for long periods of time.
• Transport the instrument in its padded hard-sided carrying case to prevent damage.

PRECAUTION
METER sensors are built to the highest standards, but misuse, improper protection, or improper installation may damage the sensor and possibly void the manufacturer’s warranty. Before integrating LP-80 into a system, make sure to follow the recommendations to avoid damage and voiding the warranty.

2.1 CONFIGURING
Before taking measurements, configure the LP-80 date, time, and location to ensure accurate timestamps and measurement readings. The date and time can also be changed using the LP-80 Utility (Section 3.3), which automatically sets the date and time on the LP-80 each time it is connected.

Use the following steps to configure the LP-80 prior to readings.
1. Press the POWER button to turn on the LP-80.
2. Press MENU to navigate to the Configuration tab (Figure 1).

3. Use UP and DOWN to highlight Location.
4. Press ENTER.
   The system location will display as options Country, City, Latitude, and Longitude (Figure 2).

Table 3  Typical \( \chi \) Values

<table>
<thead>
<tr>
<th>Crop</th>
<th>( \chi )</th>
<th>Crop</th>
<th>( \chi )</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ryegrass</td>
<td>0.67–2.47</td>
<td>Rape</td>
<td>1.92–2.13</td>
</tr>
<tr>
<td>Maize</td>
<td>0.76–2.52</td>
<td>Cucumber</td>
<td>2.17</td>
</tr>
<tr>
<td>Rye</td>
<td>0.80–1.27</td>
<td>Tobacco</td>
<td>1.29–2.22</td>
</tr>
<tr>
<td>Wheat</td>
<td>0.96</td>
<td>Potato</td>
<td>1.70–2.47</td>
</tr>
<tr>
<td>Barley</td>
<td>1.20</td>
<td>Horse bean</td>
<td>1.81–2.17</td>
</tr>
<tr>
<td>Timothy</td>
<td>1.13</td>
<td>Sunflower</td>
<td>1.81–2.31</td>
</tr>
<tr>
<td>Sorghum</td>
<td>1.43</td>
<td>White clover</td>
<td>2.47–3.26</td>
</tr>
<tr>
<td>Lucerne</td>
<td>1.54</td>
<td>Strawberry</td>
<td>3.03</td>
</tr>
<tr>
<td>Hybrid swede</td>
<td>1.29–1.81</td>
<td>Jerusalem Artichoke</td>
<td>2.16</td>
</tr>
<tr>
<td>Sugar beet</td>
<td>1.46–1.88</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Long-Term Stability
The output of all radiation sensors tends to drift over time as the detector ages. The long-term shift of the sensor is <3% per year.

PAR Photosynthetically active radiation (PAR) is the radiation in the 400- to 700-nm waveband. It represents the portion of the spectrum which plants use for photosynthesis. Under a plant canopy, radiation levels can vary from full sun to almost zero over the space of a few centimeters. Reliable measurements require many samples at different locations under the canopy. Intercepted PAR data can be used for determining important parameters of canopy structure and for the calculation of LAI. An external point sensor may be used to collect instantaneous above-canopy PAR measurements when sampling under or within a canopy.

Spectral Response
An ideal quantum sensor would give equal emphasis to all photons between 400 and 700 nm and would exclude photons above and below these wavelengths. Quantum sensors, such as the Apogee, that approximate the ideal response with filters are accurate to within ±3% for common light sources. The spectral response of the Apogee sensor is such that it underestimates the 400- to 500-nm wavelengths (blue light), matches in the 550- to 650-nm wavelengths (yellow and orange), and has little sensitivity above 650 nm (red light). Fortunately, common light sources are mixtures of colors and many spectral errors offset each other.

\( \tau \) is another variable in the LAI inversion equations. It is the ratio of below-canopy PAR measurements to the most recent above-canopy PAR value. It is measured automatically by the instrument, based upon the PAR readings. The current \( \tau \) value is displayed and updated in the lower left corner of the screen in the PAR tab.

Zenith Angle \( z \) is the angle between the point in the sky directly overhead and the position of the sun (Figure 36). The zenith is 0° and the horizon is 90°. The zenith angle of the sun is necessary for calculation of certain canopy structure parameters, such as LAI. It is
GLOSSARY

**Cosine Response**  The cosine error for the external sensor for typical applications is <1%.

**External Sensor**  An external PAR sensor allows the LP-80 to make simultaneous above- and below-canopy PAR measurements. This makes multiple PAR measurements under the canopy in variable light conditions without having to keep moving the instrument in and out of the canopy to update the above-canopy PAR reference. The external sensor is also the PAR standard to which the probe is calibrated.

**Fraction of Beam Radiation** ($F_b$)  $F_b$ is the ratio of direct beam radiation coming from the sun to radiation coming from all ambient sources like the atmosphere or reflected from other surfaces. A fractional beam radiation value is necessary for calculation of LAI using PAR data. The LP-80 obtains this value by comparing the above-canopy PAR measurement to the calculated value of potential incoming solar radiation at the location and zenith angle. The current calculated $F_b$ is displayed and updated at the bottom of the screen in the PAR tab.

**Leaf Area Index (LAI)**  LAI is the area of leaves per unit area of soil surface. It is a valuable measurement in helping to assess canopy density and biomass. The LP-80 calculates LAI based on the above- and below-canopy PAR measurements along with other variables that relate to the canopy architecture and position of the sun. These variables are the zenith angle, a fractional beam measurement value, and a leaf area distribution parameter for the particular canopy.

**Leaf Distribution Parameter** ($\chi$)  $\chi$ refers to the distribution of leaf angles within a canopy and is the ratio of the length of the horizontal to the vertical axis of the spheroid described by the leaf angle distribution of a canopy. It can also be measured as the ratio of the projected area of an average canopy element (a leaf, for example) on a horizontal plane to its projection on a vertical plane. The default value for $\chi$ is 1.0, which assumes the canopy angle distribution to be spherical. Onions are a good example of a strongly vertical crop. For onions, $\chi$ would be about 0.7. On the other extreme, strawberries, a crop with a strongly horizontal nature, would have a $\chi$ value of about 3.

Table 3 gives some typical values for $\chi$. In some cases a range of values is given, indicating the variability that is to be expected for $\chi$ in any canopy. Fortunately, the value of LAI computed is not strongly dependent on the value of $\chi$ chosen. The LP-80 uses a value of $\chi = 1.0$ as its default.

---

5. Use **UP** and **DOWN** to highlight the desired options, and press **ENTER** to access the lists to update the selections appropriately.
6. Press **ESC** when all displayed location information is correct.
7. Press **DOWN** to highlight **Date**.
8. Press **ENTER**.

The system date appears in the center of the screen in day/month/year format (Figure 3). Arrows appear above and below the first value, indicating the value can be edited.

9. Use **UP** and **DOWN** to change the first number. Holding down the arrow buttons will scroll quickly between values.
10. Press **ENTER** to move to the next value or **ESC** to return to the previous value.
11. Repeat steps 9 and 10 until the correct date is selected.
12. After the last value is changed, press **ENTER** to return to the Configuration tab.
13. Use **DOWN** to highlight **Daylight Savings**.
14. Use **ENTER** to toggle daylight savings to **On** or **Off**.
15. Use **UP** to highlight **Time**.
16. Press **ENTER**.
   The system time appears in the center of the screen in 24-h format (Figure 4). Arrows appear above and below the first value, indicating the value can be edited.

![Time screen](Figure 4 Time screen)

17. Use **UP** and **DOWN** to change the first number. Holding down the arrow buttons will scroll quickly between values.
18. Press **ENTER** to move to the next value or **ESC** to return to the previous value.
19. Repeat step 17 and step 18 until the correct time is selected.
20. After the last value is changed, press **ENTER** to return to the Configuration tab.
21. Press **MENU** to return to the main screen.

### 2.2 TAKING MEASUREMENTS

The LP-80 measures PAR using the sensors in the probe. Under a plant canopy, radiation levels can vary, so reliable measurement of PAR requires many samples at different locations. An external point sensor may be used to collect instantaneous above-canopy PAR measurements when sampling under or within a canopy.

Intercepted PAR data can be used for determining important parameters of canopy structure and for the calculation of LAI. The LP-80 uses several variables to calculate Leaf Area Index (LAI) and displays values for these variables on the screen as measurements are taken (Figure 5).

### REFERENCES

4.5 CUSTOMER SUPPORT

NORTH AMERICA
Customer service representatives are available for questions, problems, or feedback Monday through Friday, 7:00 am to 5:00 pm Pacific time.

Email: support.environment@metergroup.com
Phone: +1.509.332.5600
Fax: +1.509.332.5158
Website: metergroup.com

EUROPE
Customer service representatives are available for questions, problems, or feedback Monday through Friday, 8:00 to 17:00 Central European time.

Email: support.europe@metergroup.com
Phone: +49 89 12 66 52 0
Fax: +49 89 12 66 52 20
Website: metergroup.de

If contacting METER by email, please include the following information:

| Name | Email address | Address | Phone | Instrument serial number | Description of the problem |

NOTE: For products purchased through a distributor, please contact the distributor directly for assistance.

4.6 TERMS AND CONDITIONS

By using METER instruments and documentation, you agree to abide by the METER Group, Inc. Terms and Conditions. Please refer to metergroup.com/terms-conditions for details.

Par: radiation in the 400- to 700-nm waveband, representing the portion of the spectrum that plants use for photosynthesis.

τ: ratio of below-canopy PAR measurements to the most recent above-canopy PAR measurement, calculated automatically by the LP-80.

LAI: the area of leaves per unit area of soil surface.

Fb: fraction of direct beam radiation coming from the sun to radiation gathered from all ambient sources, like the atmosphere, or reflected from other surfaces.

χ: leaf distribution parameter: ratio of the projected area of an average canopy element (a leaf, for example) on a horizontal plane to its projection on a vertical plane; the default value for χ is 1.0, which assumes the canopy angle distribution to be spherical.

z: zenith angle: angle between the point in the sky directly overhead vertical, called the zenith (0°), and the position of the sun. The angle is calculated based on the global position, time of day, and location, and the correct information must be configured in the LP-80 for this value to be accurate (Section 2.1).

More in-depth explanations and examples of these measurements are in Section 3.4 and the Glossary.

The LP-80 can take measurements either manually or in unattended logging mode, as explained in Section 2.2.2 and Section 2.2.3, respectively.

2.2.1 MEASUREMENT TIPS

ABOVE-CANOPY (EXTERNAL) SENSOR
For above-canopy PAR data collection, consider connecting the external sensor to the LP-80. This ensures an accurate measurement of intercepted PAR, especially on days where radiation levels vary rapidly. The sensor can be mounted on a tripod and leveled with a bubble level.
OPERATION

When it is not feasible to use an external sensor to obtain above-canopy measurements, such as in timber or tropical crops, choose one of two options:

Use a separate data logger with an attached PAR sensor (such as a point quantum sensor) or configure another LP-80 to log in the unattended mode (one reading per minute, for example) in a clearing outside the canopy. After collecting PAR data within the canopy, download the data from the two instruments to a computer and correlate the data.

Use the LP-80 as an above-canopy reference by regularly collecting above-canopy PAR data in a large clearing within the canopy structure.

SAMPLE SIZE

When evaluating experimental protocols for measuring average intercepted PAR and determining average LAI for a large area, plan for a sufficient number of samples and sampling locations. This will reduce errors caused by canopy structure variations.

ACTIVE PROBE SEGMENTS

When evaluating discontinuous canopies or canopies with definite clumping, the LP-80 can be configured such that its active sampling area is reduced or you can download the data collected by the probe segments. In this way, information can be gathered that better describes the changes in canopy structure with regard to location. Reduce the sampling size of the probe using the Set Active Segments option in the Configuration tab. View the individual PAR readings for each of the eight probe segments by downloading the stored data to the computer.

The number of active segments in the probe can also be changed to limit the number of active sensors along the probe or to reflect spatial changes in the plant canopy (Section 3.2.1). This is useful when evaluating discontinuous and irregular canopies.

SAMPLING IN ROW CROPS

When using the LP-80 to measure in crop rows, take measurements in a way to give a good row-to-row representation of the entire below-canopy PAR environment both under the plants and between rows. METER suggests either of the sampling regimes below, where the probe either extends from mid-row to mid-row (Figure 6) or extends from mid-row to the middle of the open space between rows (Figure 7), depending on row width and canopy size.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error message: Firmware is corrupted! See Manual for options.</td>
<td>This screen means that the firmware was not loaded properly or an update is needed. Check <a href="https://meter.ly/lp-80-support">https://meter.ly/lp-80-support</a> if a new firmware version is available. NOTE: Saved data records will be lost when new firmware is installed. Download any data before reloading the new firmware. If a newer firmware version is not available, contact Customer Support.</td>
</tr>
<tr>
<td>Error message: Cannot change settings while logging!</td>
<td>Configuration settings are locked during active reading or logging mode to prevent inconsistent data from being saved. Navigate to the PAR or Log tab and exit the active reading. Make the desired changes in the Configuration tab and begin a new reading.</td>
</tr>
<tr>
<td>Error message: One mode can be run at a time. Press ENTER to stop logging and begin reading.</td>
<td>Only one mode (either PAR or Log) may be running at a time. Press ENTER to stop the currently running mode and to continue with the new mode, or press MENU to proceed to the next tab without changing the mode.</td>
</tr>
<tr>
<td>Error message: No summary data.</td>
<td>The view menu only allows you to view summary records. If you have not saved any records or if you only have saved above and below records, this message will appear when trying to view or download data. To make this message go away, save a summary record on the PAR or Log menu by pressing ENTER.</td>
</tr>
<tr>
<td>Warning message: By continuing, you will lose any custom information. Press ENTER to continue or ESC to cancel.</td>
<td>This message will appear when overriding custom location information. Press ENTER to continue with new information or press ESC to preserve old customer information.</td>
</tr>
</tbody>
</table>
4.4 TROUBLESHOOTING

Table 2 lists common problems and their solutions. If the problem is not listed or these solutions do not solve the issue, contact Customer Support.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instrument doesn't turn on</td>
<td>Check that the batteries are inserted correctly. Replace the batteries.</td>
</tr>
<tr>
<td>Display is difficult to see</td>
<td>Navigate to the Configuration tab. Adjust the contrast. Scroll down to Contrast. Use the UP and DOWN to adjust screen contrast level. Replace the batteries.</td>
</tr>
<tr>
<td>Error message</td>
<td>Check the connection between the external sensor and the LP-80.</td>
</tr>
<tr>
<td>The external sensor reading of 0 μmol/(m²s) is too low. Please try again</td>
<td>Move the external sensor to full sun and retry. If the day is overcast, wait to calibrate the sensor on a sunny day when PAR levels are above 600 μmol/(m²s).</td>
</tr>
<tr>
<td>The LAI output is 0 even though there is a valid above and below canopy PAR reading</td>
<td>Check the zenith angle value (z) on the PAR screen. z should be between 0 to 90 degrees. If it is greater than 90 degrees, the time or latitude/longitude are most likely incorrect. Set the date, time, and location correctly (Section 2.1).</td>
</tr>
<tr>
<td>Warning message Low battery</td>
<td>Check that the batteries are inserted correctly. Replace the batteries.</td>
</tr>
<tr>
<td>Warning message Date and time were reset! Update the date and time</td>
<td>Navigate to the Configuration tab and verify the date and time are set properly (Section 2.1).</td>
</tr>
<tr>
<td>Error message Data erase failed! Replace batteries. After replacing batteries, press ENTER to continue</td>
<td>Replace the batteries and turn the LP-80 back on. Press ENTER when to exit this screen.</td>
</tr>
<tr>
<td>Error message Missing bootstrap loader! See Manual for options</td>
<td>The instrument cannot download new firmware updates. The instrument must be serviced by METER. Contact Customer Support.</td>
</tr>
<tr>
<td>Error message Memory Full</td>
<td>Download data records to a computer (Section 2.5) and erase the LP-80 memory (Section 2.6).</td>
</tr>
</tbody>
</table>

2.2.2 MANUAL MEASUREMENTS

1. Navigate to the PAR tab.

2. To make an above-canopy PAR measurement, press UP. The resulting value displays in the upper right section of the screen.

3. To make measurements below the canopy, plug in an external sensor or take an above canopy PAR reading first before the summary data can update. If the external sensor is attached, the LP-80 records both above- and below-canopy readings pressing either the UP or DOWN.
4. To make measurements below the canopy, press **DOWN** or **PAR-LAI** in the upper right corner of the keypad.

   The LP-80 recalculates summary data after each below-canopy PAR reading. Other relevant data displays at the bottom of the screen (Figure 8).

   ![Figure 8](image)

   **Figure 8** Active PAR measurement screen

   LP-80 updates and displays the current calculated \( \tau \), LAI, \( F_b \), \( \chi \), and \( z \) values at the bottom of the screen with each subsequent below-canopy PAR measurement.

   With each above- or below-canopy measurement, a number appears to the right of the PAR value that indicates the number of completed measurements. The displayed PAR value reflects the sample average. In Figure 8, the LP-80 made four above and three below-canopy measurements, so the average of the four above-canopy PAR values is 211 \( \mu \text{mol}/(\text{m}^2\text{s}) \), while the average of the three below-canopy values is 20 \( \mu \text{mol}/(\text{m}^2\text{s}) \).

   **NOTE:** When connected to the external sensor, the LP-80 uses readings from the external sensor as above-canopy PAR readings to calculate LAI. Summary data on the bottom of the screen are recalculated using the last above-canopy reading with each subsequent below-canopy reading.

5. Press **ENTER** to bring up the Save screen to save as is, annotate, or discard (Section 2.3). Press **ESC** to discard the values.

   Both options clear the screen for new data.

### 2.2.3 LOG MODE MEASUREMENTS

**NOTE:** LAI and \( \tau \) are calculated more accurately by manually sampling PAR beneath a canopy at random locations instead of leaving the LP-80 in one place and collecting data in log mode.

1. Navigate to the Log tab.
2. Select the measurement interval by pressing the **UP** or **DOWN** arrows to select any value between 1 and 60 min.
3. To activate the logging mode, press **ENTER**. The screen will begin to return data (Figure 9).
4. To cancel the logging mode, press **ESC**.

   **NOTE:** Other tabs can be viewed while the logging mode is activated.

6. Insert new batteries, following the indicators on the battery holders.

   **NOTE:** Ensure batteries are oriented properly; placing them the wrong way can damage the LP-80.

7. Press the **RESET** button on the top left corner of the green circuit board.

8. Rotate the cover back into position.

9. Turn the LP-80 over, with the screen facing down.

10. Replace the four washers and screws into the back cover.

### 4.2.2 CLEANING THE PROBE AND CONTROLLER

The probe should always be clean to ensure accurate readings. To clean the probe, use a soft cloth and a small amount of isopropyl alcohol. Rub the surface until it is clean.

To clean the controller, use a soft cloth and water to wash off heavy dirt, then use ethyl or isopropyl alcohol to finish cleaning.

   **NOTE:** Only use a soft cloth when cleaning the LCD window. Tissues made from wood fiber will scratch the window.

### 4.3 REPAIR

METER repairs manufacturer defects and instruments within the 1-year warranty at no charge. Repairs outside the warranty window are charged based on cost of parts, labor, and shipping. An extra fee may be charged for rush work. METER will provide an estimated repair cost, if requested.

All LP-80 instruments returning to METER for servicing must be accompanied with a Return Material Authorization (RMA) number. Prior to shipping the instrument, please contact Customer Support to obtain an RMA number.

1. Place the LP-80 in a plastic bag to avoid disfiguring marks from the packaging.
2. Do not ship any accessories.
3. Ship the LP-80 in its original case.
4. On the RMA form, please verify the ship to and bill to information, contact name, and problem description. If anything is incorrect, please contact Customer Support.
5. Tape the box in both directions for added support.
6. Include the RMA number in the attention line on the shipping label.
3. Holding the case together, turn the LP-80 over, with the screen facing up.
4. Carefully lift the cover and rotate along the bottom to lay the front cover down (Figure 35).
5. Remove and discard old batteries.

5. Remove and discard old batteries.

2.3 SAVING AND ANNOTATING READINGS

To save a reading after taking above and below PAR data,

1. Press ENTER.

The Save Method screen appears (Figure 10).

2. Choose to save, annotate, or discard data.
   - Save: data stores with the time and date of the measurement.
   - Discard: return to the main screen and start over with a new reading.
   - Annotate: create a file name or description (Figure 11).
OPERATION

2.4 VIEWING DATA

To view prior test results, use the following steps:

1. Press MENU to navigate to the Data tab (Figure 12).
2. Press ENTER to select View.
3. Scroll through the list of saved tests using UP and DOWN (Figure 13).

4.2 MAINTENANCE

LP-80 may be returned to METER for maintenance in the following areas: system inspection, parts replacement, and instrument cleaning. Replacement parts can also be ordered from METER. Contact Customer Support for more information.

4.2.1 REPLACING BATTERIES

The LP-80 uses four standard 1.5-V AAA alkaline batteries. These batteries are easily obtained and should last for at least 2 years before they should be replaced. If a battery icon appears in the upper right corner of the screen or a low battery message is displayed, follow these instructions to change the batteries.

NOTE: Data will not be lost when the batteries are replaced. The LP-80 memory and program sections are nonvolatile.

1. Place the LP-80 with the screen facing down.
2. Use the included Phillips screwdriver to remove the four screws and washers (Figure 34).
Figure 30  Level the LP-80 probe and external sensor

5. Turn on the LP-80.
6. Press ENTER to check that the PAR level meets the 600 μmol/(m² s) threshold for calibration. If necessary, adjust the sun exposure of the LP-80 to meet the threshold.

**NOTE:** The PAR level must be above 600 μmol/(m² s) for the calibration to update. In general, a clear day where the sun is visible will be above 600 μmol/(m² s). Overcast days are typically less than 600 μmol/(m² s).

7. Press MENU to navigate to the Configuration tab.
8. Press ENTER to select Calibration. A reminder screen will appear (Figure 31).

9. Move out of the probe area to minimize any interference with the measurement.
10. Press ENTER to perform the calibration. The current probe calibration will display graphically (Figure 32). (If no external sensor is attached while performing the calibration, the calibration will return an error.)

2.5 DOWNLOADING DATA

METER recommends using the LP-80 Utility to download data. This function transfers all saved measurement data on the LP-80 to a computer.

1. Connect the 5-pin connector to the LP-80.
2. Connect the RS-232 end of the cable to an available serial port on a computer or to a USB-to-serial adapter.
3. Turn on the LP-80 by pressing the POWER button.
4. Open LP-80 Utility.
5. Choose the appropriate communication port from the Use computer communication port dropdown on the main window.
6. Click Download in the lower left of the screen or click File > Download Data. The Save LP-80 Data dialog box will appear.
7. Name the data file.
8. Choose the location and the format for the file (Section 3.3). The file can be saved as one of the following:
   - Microsoft® Excel® Workbook (*.xls)
   - Text (tab delimited) (*.txt)
   - CSV (comma delimited) (*.csv)
9. Click Save to download. A progress bar shows the status of the download process.
10. Press Cancel to cancel the download at any time. The software will not save any downloaded data.
11. When the download is finished, a prompt will ask to erase the data on the LP-80.
12. Select the desired response.
13. Navigate to the saved file location and open the file to view the data.

Data are organized in the same way regardless of format. The measurement record will be divided into several columns.

- **Record Type:** The data record type (SUM, ABV, or BLW).
- **Date and Time Measurement:** Date and time of the reading.
- **Annotation:** The annotation is a string that a user may use to identify the reading.
- **Average Above PAR:** The average of all the above-canopy PAR readings for the raw records associated with the summary record.
- **Average Below PAR:** The average of all the below-canopy PAR readings for the raw records associated with the summary record.
- $\tau$: Ratio of below-canopy PAR measurements (MeanBlw) to the above-canopy PAR measurements (MeanAbv).
- **LAI:** Area of leaves per unit area of soil surface.
- $\chi$: Ratio of projected area of an average-canopy element on a horizontal plane to its projection on a vertical plane.
- $F_b$: Ratio of direct beam radiation coming directly from the sun to radiation coming from all ambient sources.
- $z$: Angle the sun makes with respect to the zenith (point in sky directly overhead).
- **Latitude:** Latitude location in degrees.
- **Longitude:** Longitude location in degrees.
- **Segment 1–8 PAR:** Individual PAR readings from each of the eight segments.
- **External Sensor PAR:** PAR reading from the external sensor.
- **Record ID (RID):** Unique identifier for each record.
- **Raw Record ID:** RID of the first raw record associated with the summary record. Any record between the RawRID and the RID of the summary record is also associated with the summary record.

Data can also be downloaded through the LP-80 or a terminal program, if the LP-80 Utility is not functioning properly. Contact Customer Support for more information.

### 2.6 ERASING DATA

Data can be erased using the LP-80 or the LP-80 Utility. Data cannot be erased one measurement at a time. This feature erases all data from the LP-80 permanently and it cannot be recovered!

**NOTE:** Once data has been erased, it cannot be recovered.

To erase all stored data from LP-80:

4. **SERVICE**

This section describes the calibration and maintenance of the LP-80. Troubleshooting solutions and customer service information are also provided.

#### 4.1 CALIBRATION

The LP-80 calibrates its sensors against the external PAR sensor (Section 3.2.2). However, as is the case with all electronic components, the external sensor sensitivity will shift over time. As a result, METER recommends sending the external sensor to METER for recalibration. For external PAR sensors that are used heavily, annual calibration is recommended. For periodic use, one recalibration every 2 to 3 years should be adequate.

METER recommends recalibrating the LP-80 to the external PAR sensor at least once per hour to maintain a stable calibration between the two sensors.

Use the following steps to calibrate the LP-80 to the external PAR sensor.

1. Unscrew the bolt from the external PAR sensor.
2. Place the external PAR sensor above the hole in the bubble level of the LP-80.
3. Insert the bolt through the hole in the LP-80 from back to front and screw into the external PAR sensor until hand-tight (Figure 29).

![Figure 29 Level the probe](image)

**NOTE:** The LP-80 can also be calibrated on a flat board or platform propped at an angle to get more direct sunlight.
EXAMPLE PROBLEM 7
Find the zenith angle for Pullman, Washington, USA at 10:45 PDT on June 30. Convert the time of observation to standard time by subtracting 1 h and convert minutes to decimal hours, so $t = 9.75$ h.

June 30 is $J = 181$.

Pullman latitude is 46.77°, or 0.816 radians, and longitude is 117.2°.
The standard meridian for Pullman is 120°.
The local meridian is $2.8°$ east of the standard meridian, so $LC = 2.8/15 = 0.19$ h.

From Equation 51, $ET = -0.06$ h. Equation 50 then gives $t = 12 - 0.19 - (-0.06) = 11.87$.

Declination from Equation 49 is 0.4 radians.

Substituting these values into Equation 48 gives:

$$\theta = \arccos \left[ \sin(0.816) \sin(0.4) + \cos(0.816) \cos(0.4) \cos[0.2618(9.75 - 11.87)] \right]$$

$$= 0.61 \text{ radians} \quad \text{Equation 52}$$

The LP-80 automatically determines zenith angle using the above equation and parameters. Once correct values are entered in the Configuration tab (Section 2.1), the LP-80 determines zenith angle without further input. The zenith of the sun angle will then be calculated and stored at the end of each data set.

1. Press MENU to navigate to the Data tab.
2. Use UP or DOWN to highlight Erase.
3. Press ENTER.

The following warning will appear (Figure 15).

4. To return to the Data tab and leave stored data intact, press ESC.
To erase data from memory, press ENTER.

NOTE: This will delete all data permanently.
When the process is complete, the Data tab will reappear.

To erase all stored data using the LP-80 Utility:
1. Make sure the LP-80 is properly connected to the computer.
2. Click Erase in the lower left of the screen, or go to File > Erase Data.
A confirmation dialog box will appear.
3. Click OK to continue.
Click Cancel to return to the main screen.
A progress bar will appear on the main screen, indicating that data is being erased.
3. SYSTEM
This section describes the specifications, components, and theory of the LP-80.

3.1 SPECIFICATIONS

MEASUREMENT SPECIFICATIONS

<table>
<thead>
<tr>
<th>Probe PAR Sensors</th>
<th></th>
<th>External PAR Sensor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range</td>
<td>0 to 2,500 μmol/(m²s)</td>
<td>0 to 4,000 μmol/(m²s) (full sunlight ~2,000 μmol/(m²s))</td>
</tr>
<tr>
<td>Resolution</td>
<td>1 μmol/(m²s)</td>
<td>1 μmol/(m²s)</td>
</tr>
<tr>
<td>Accuracy</td>
<td>±5%</td>
<td></td>
</tr>
</tbody>
</table>

Unattended Logging Interval
Between 1 and 60 min (user selectable)

PHYSICAL SPECIFICATIONS

<table>
<thead>
<tr>
<th>Controller Dimensions</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>15.80 cm (6.20 in)</td>
</tr>
<tr>
<td>Width</td>
<td>9.50 cm (3.75 in)</td>
</tr>
<tr>
<td>Height</td>
<td>3.30 cm (1.30 in)</td>
</tr>
<tr>
<td>Weight</td>
<td>0.55 kg (1.21 lb)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Probe Dimensions</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>86.5 cm (34.06 in)</td>
</tr>
<tr>
<td>Width</td>
<td>19.0 mm (0.75 in)</td>
</tr>
<tr>
<td>Height</td>
<td>9.5 mm (0.38 in)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>External Sensor Dimensions</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Diameter</td>
<td>24.0 mm (0.94 in)</td>
</tr>
<tr>
<td>Height</td>
<td>27.0 mm (1.06 in)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Probe Sensors</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>80</td>
</tr>
<tr>
<td>Type</td>
<td>Photosynthetically active radiation sensor</td>
</tr>
</tbody>
</table>

Table 1: Solar Declination and Equation of Time

<table>
<thead>
<tr>
<th>Date</th>
<th>Day of Year</th>
<th>D (Radians)</th>
<th>ET Hour</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan 1</td>
<td>1</td>
<td>-0.403</td>
<td>-0.057</td>
</tr>
<tr>
<td>Jan 10</td>
<td>10</td>
<td>-0.386</td>
<td>-0.123</td>
</tr>
<tr>
<td>Jan 20</td>
<td>20</td>
<td>-0.355</td>
<td>-0.182</td>
</tr>
<tr>
<td>Jan 30</td>
<td>30</td>
<td>-0.312</td>
<td>-0.232</td>
</tr>
<tr>
<td>Feb 0</td>
<td>40</td>
<td>-0.261</td>
<td>-0.280</td>
</tr>
<tr>
<td>Feb 10</td>
<td>10</td>
<td>-0.202</td>
<td>-0.232</td>
</tr>
<tr>
<td>Mar 0</td>
<td>30</td>
<td>-0.138</td>
<td>-0.208</td>
</tr>
<tr>
<td>Mar 11</td>
<td>11</td>
<td>-0.071</td>
<td>-0.117</td>
</tr>
<tr>
<td>Mar 21</td>
<td>21</td>
<td>-0.002</td>
<td>-0.122</td>
</tr>
<tr>
<td>Mar 31</td>
<td>31</td>
<td>0.067</td>
<td>-0.072</td>
</tr>
<tr>
<td>Apr 10</td>
<td>10</td>
<td>0.133</td>
<td>-0.0340</td>
</tr>
<tr>
<td>Apr 20</td>
<td>20</td>
<td>0.196</td>
<td>0.0170</td>
</tr>
<tr>
<td>Apr 30</td>
<td>30</td>
<td>0.253</td>
<td>0.0460</td>
</tr>
<tr>
<td>May 10</td>
<td>10</td>
<td>0.304</td>
<td>0.0690</td>
</tr>
<tr>
<td>May 20</td>
<td>20</td>
<td>0.346</td>
<td>0.0980</td>
</tr>
<tr>
<td>May 30</td>
<td>30</td>
<td>0.378</td>
<td>0.0430</td>
</tr>
<tr>
<td>Jun 10</td>
<td>10</td>
<td>0.409</td>
<td>-0.0190</td>
</tr>
<tr>
<td>Jun 20</td>
<td>20</td>
<td>0.406</td>
<td>-0.0950</td>
</tr>
<tr>
<td>Jul 10</td>
<td>10</td>
<td>0.392</td>
<td>-0.0850</td>
</tr>
<tr>
<td>Jul 20</td>
<td>20</td>
<td>0.366</td>
<td>-0.1090</td>
</tr>
<tr>
<td>Jul 30</td>
<td>30</td>
<td>0.331</td>
<td>-0.1070</td>
</tr>
<tr>
<td>Aug 10</td>
<td>10</td>
<td>0.286</td>
<td>-0.0970</td>
</tr>
<tr>
<td>Aug 20</td>
<td>20</td>
<td>0.233</td>
<td>-0.0850</td>
</tr>
<tr>
<td>Aug 30</td>
<td>30</td>
<td>0.174</td>
<td>-0.0220</td>
</tr>
<tr>
<td>Sep 10</td>
<td>10</td>
<td>0.111</td>
<td>0.0381</td>
</tr>
<tr>
<td>Sep 20</td>
<td>20</td>
<td>0.045</td>
<td>0.0890</td>
</tr>
<tr>
<td>Sep 30</td>
<td>30</td>
<td>-0.023</td>
<td>0.1470</td>
</tr>
<tr>
<td>Oct 10</td>
<td>10</td>
<td>-0.091</td>
<td>0.2010</td>
</tr>
<tr>
<td>Oct 20</td>
<td>20</td>
<td>-0.157</td>
<td>0.2430</td>
</tr>
<tr>
<td>Oct 30</td>
<td>30</td>
<td>-0.219</td>
<td>0.2800</td>
</tr>
<tr>
<td>Nov 10</td>
<td>10</td>
<td>-0.275</td>
<td>0.2400</td>
</tr>
<tr>
<td>Nov 20</td>
<td>20</td>
<td>-0.324</td>
<td>0.2900</td>
</tr>
<tr>
<td>Nov 30</td>
<td>30</td>
<td>-0.363</td>
<td>0.2130</td>
</tr>
<tr>
<td>Dec 10</td>
<td>10</td>
<td>-0.391</td>
<td>0.1510</td>
</tr>
<tr>
<td>Dec 20</td>
<td>20</td>
<td>-0.406</td>
<td>0.0750</td>
</tr>
<tr>
<td>Dec 30</td>
<td>30</td>
<td>-0.408</td>
<td>-0.0070</td>
</tr>
</tbody>
</table>
3.4.7 ZENITH ANGLE AND EQUATION OF TIME

The formulas for calculating elevation angle are relatively straightforward. The zenith angle is calculated with Equation 48:

\[ \Psi = \arccos[\sin(Lat) \sin(D) + \cos(Lat) \cos(D) \cos(0.2618(t - t_0))] \]

Equation 48

using the following definitions:

- \( Lat \): the latitude (negative in the Southern Hemisphere). Latitude of a given site is easily found in an atlas or using a GPS system.
- \( D \): solar declination (Equation 49), which ranges from +0.409 radians (+23.45°) at summer solstice to −0.409 radians (−23.45°) at winter solstice:

\[ D = \arcsin[0.39785 \sin(4.869 + 0.0172J + 0.03345 \sin(6.224 + 0.0172J))] \]

Equation 49

where \( J \) is the day of the year.
- 2.618 = conversion of hours to radians (Earth turns at a rate of 0.2618 radians/h)
- \( t \): time (in hours from 0 to 24).
- \( t_0 \): time of solar noon:

\[ t_0 = 12 - LC - ET \]

Equation 50

where \( LC \) is the longitude correction and \( ET \) is the Equation of Time.

Longitude correction is +4 min, or +1/15 h for each degree east of the standard meridian and −1/15 h for each degree west of the standard meridian. Standard meridians are at 0°, 15°, 30°, etc. Generally, time zones run approximately +7.5° to −7.5° on either side of a standard meridian, but this varies depending on political boundaries, so check an atlas to find both standard meridian and longitude. Typically, longitudes in the Eastern Hemisphere are given as negative values.

The Equation of Time is a 15- to 20-min correction that depends on the day of the year. It can be calculated from:

\[ ET = \frac{-104.7 \sin(\phi) - 59.2 \sin(3\phi) + 4.3 \sin(5\phi) - 12.7 \cos(\phi) - 429.3 \cos(3\phi) - 2.0 \cos(5\phi) + 19.3 \cos(7\phi)}{3600} \]

Equation 51

where \( \phi \) = (279.575 + 0.986 J)/180. Some values for \( ET \) are given in Table 1.
The LP-80 can be operated in environments with temperatures from 0 to 50 °C and in relative humidities of up to 100%. The LP-80 operates on four AAA alkaline batteries. The instrument ships with an RS-232 interface cable for downloading data to a computer.

### 3.2.1 PROBE

The probe contains 80 independent sensors, spaced 1 cm apart. The photosensors measure photosynthetically active radiation in the 400- to 700-nm waveband.

For some applications, the entire probe may not be needed. The LP-80 allows sections of the probe to be turned off, starting from the base and continuing up the probe to the tip (Section 2.2.1).

### 3.2.2 EXTERNAL PAR SENSOR

The LP-80 has an external PAR sensor that attaches to the hole in the bubble level and connects to the port on the right side of the LP-80. It allows for simultaneous above- and below-canopy PAR readings without moving the LP-80 above and below the canopy. The LP-80 uses this sensor to calibrate the probe, ensuring that the PAR response between the external sensor and the probe are the same (Section 4.1).

The external quantum sensor provided with the LP-80 is the Apogee SQ100X. This sensor offers good accuracy; however, the biggest potential error is often caused by small changes in the position of the sensor. The sensor must be exactly horizontal for the most accurate measurements.

### 3.4.6 LAI MEASUREMENTS AND NONRANDOM DISTRIBUTION

Since all inversion methods to obtain LAI rely on the assumption that elements of a canopy are randomly dispersed in space, errors in the measurement of LAI may result from a nonrandom arrangement of canopy elements. This is especially true for canopies with heliotropic leaves, conifer forests, row crops before canopy closure, or canopies which never close, as in desert vegetation. The degree of error in measurement is a result of the canopy deviation of the canopy from this random dispersion assumption.

Past studies use LAI to relate both actual biomass area and the interception of PAR by a plant canopy. Another proposed view regarding LAI, in which \( L \), the actual biomass area, relates to a new term \( L_e \), which represents the actual orientation of the canopy elements relating to the interception of PAR at a given angle. In situ measurements of LAI using hemispherical photography were equated with this new term “effective plant area index” \( L_e \), which was defined as:

\[
L_e = \Omega \cdot L
\]

where \( L \) represents the actual LAI (equal to a harvested leaf area measurement) and \( \Omega \) refers to a clumping index resulting from the nonrandom distribution of canopy elements.

When a canopy displays random dispersion, \( \Omega \) is unity; however, when a canopy is clumped, \( \Omega \) is not unity. In a randomly dispersed canopy, \( L \) would be equal to \( L_e \) (Figure 28). In an underdispersed canopy (clumped), \( L \) would be greater than \( L_e \) (leaves preferentially shade the leaves). In an overdispersed canopy, \( L \) would be less than \( L_e \) (leaves are in the open spaces).

The purpose of this discussion is to expose the possible errors that may occur when making LAI measurements in situ. When setting up an experiment, carefully examine the desired end result. If the only measurement of interest is interception of PAR within a canopy, the apparent leaf or plant area index that is calculated through inversion will be an accurate portrayal of the canopy structure and orientation with respect to light interception. In this instance, while clumping effects within the canopy remain present, these effects do not cause error with regard to light interception and the effective area index for that situation.

Alternately, if obtaining the actual biomass (represented by \( L \) in this discussion) is desired, all measurements should be performed to minimize the effects of clumping. The method used in the LP-80 to compute \( \tau \) follows the recommendation of Lang and Yueqin (1986) for minimizing clumping effects. Measuring at certain times of day or at positions within the canopy may also directly minimize clumping effects.
where $\tau_d$ is the transmission coefficient averaged over all elevation angles. $\tau$ can be calculated from:

$$-\ln \tau_d = u L$$

where $u$ and $v$ are functions of $\chi$ which can be calculated from:

$$u = 1 - 0.33 \exp(-0.57\chi)$$

$$v = 1 - 0.33 \exp(-0.97\chi)$$

The following table shows typical values for $u$ and $v$.

<table>
<thead>
<tr>
<th>$x$</th>
<th>$u$</th>
<th>$v$</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.1</td>
<td>0.69</td>
<td>0.73</td>
</tr>
<tr>
<td>0.5</td>
<td>0.75</td>
<td>0.82</td>
</tr>
<tr>
<td>1.0</td>
<td>0.81</td>
<td>0.89</td>
</tr>
<tr>
<td>2.0</td>
<td>0.90</td>
<td>0.95</td>
</tr>
<tr>
<td>4.0</td>
<td>0.96</td>
<td>0.98</td>
</tr>
<tr>
<td>8.0</td>
<td>0.99</td>
<td>0.99</td>
</tr>
</tbody>
</table>

Combining Equation 22 and Equation 36 gives:

$$\tau_d = q \Theta$$

where $q = u L^{-1/H}$.

**EXAMPLE PROBLEM 6**

Calculate a value for fractional daily interception for the crop in Example Problems 4 and 5.

$$u = 1.033 \exp(-0.57 \chi) = 0.80$$

$$v = 1.033 \exp(-0.97 \chi) = 0.87$$

$$K = \frac{(0.9 - 0.35)}{0.9 + 1.774(0.9 + 1.182)^{0.5}} = 1.14 \times 1.0 = 0.50$$

$$q = \frac{0.38 \times 2.64}{0.59} = 1.2$$

$$\tau_d = 0.211 \times 0.15$$

$$f = 1 - \tau_d = 1 - 0.15 = 0.85$$

### 3.2.3 KEYPAD

The LP-80 keypad is a 7-button panel, designed for ease of use and intuitive navigability through the operating system (Figure 17).

- **POWER**: Turns the instrument on or off. The LP-80 turns itself off automatically after 10 min of inactivity.
- **MENU**: Cycles between the four tabs.
- **UP and DOWN**: In the PAR tab, the UP arrow initiates above canopy PAR readings and the DOWN arrow initiates below canopy readings. In other tabs, they are used to navigate to items or to change numeric values.
- **PAR-LAI**: Begins a below-canopy measurement; alternative when taking multiple below-canopy PAR samples.
- **ESC**: Cancels the current PAR reading, cancels out of current options, and navigates to the left in the Annotation screen.
- **ENTER**: Saves the current PAR readings in the PAR sampling tab, selects items in other tabs, and navigates to the right in the Annotation screen.

![Figure 17 LP-80 keypad](image)

### 3.2.4 DISPLAY

The LP-80 display has four main screens: PAR, Log, Data, and Configuration. The screens are indicated by the four tabs, with the active tab in the foreground. Cycle between the four tabs by pressing the MENU and select items within each tab using the UP and DOWN arrows.
The default screen is the PAR sampling tab with real-time PAR data displayed in the center portion of the screen (Figure 18). If the battery is low, a low-battery indicator will appear between the tabs and the current time.

**PAR TAB**
The PAR tab is the PAR/LAI sampling screen, which is used for taking measurements with the LP-80 (Section 2.2).

The PAR tab in Figure 19 indicates that the current real-time PAR level is 2 μmol/(m²s) (an indoor measurement) and that the user did not take any above or below PAR measurements. If the external sensor is attached, the real-time PAR value measured by the external sensor also display above the real-time light PAR data.

**LOG TAB**
The Log tab is used to put the instrument in an unattended data logging mode (Figure 20). In this mode, the LP-80 will automatically measure and store PAR data at a specified interval (Section 2.2.3).

A more precise method for finding $\chi$ is as follows. Find values for $\chi$ and $L$ which minimize:

$$F = \sum (\ln r_i + K/L)^2$$

subject to the constraint $\chi > 0$, where $r_i$ are transmission coefficients measured at several zenith angles $L$ and the $K_i$ are the extinction coefficients for the corresponding angles.

### 3.4.5 CORRECTION OF PAR FOR SUN ANGLE
Canopy transmission ($\tau$) measured at one zenith angle can be used to predict transmission or radiation interception for other zenith angles.

**EXAMPLE PROBLEM 4**
A measurement might be made at $\Theta = 32^\circ$ from which cover $(1 - \text{transmission at } \Theta = 0)$ is to be calculated. From Equation 22:

$$\tau = \frac{K}{\ln \frac{r_1}{K_1}} + p$$

so:

$$\tau(\Theta) = \tau(\Theta)^0$$

Calculate $p$ from Equation 23:

$$p = \frac{\tau(\Theta)}{\ln \frac{r_1}{K_1}}$$

If $\Theta_1 = 0^\circ$,

$$p = \frac{\tau}{\ln \frac{r_1}{K_1}}$$

If $\chi$ is not known, assume $\chi = 1$.

**EXAMPLE PROBLEM 5**
From the measurements in Example Problem 4, find the canopy cover. Take $\Theta = 35^\circ$, $\tau = 0.21$. The $\chi$ value is 0.9.

$$\tau(0) = 0.21, \frac{0.79}{0.29} = 0.71$$

Intercepted radiation averaged over an entire day can be estimated from:

$$f = 1 - \tau$$
Figure 27 shows the extinction coefficient plotted as a function of zenith angle for various values of $\chi$. There are two important things to note. First, at a zenith angle of about 57°, $K$ is near unity for all canopies. When leaves are horizontal (large $\chi$), $K$ is unity for all elevation angles, but as $\chi$ decreases, $K$ becomes smaller at large zenith angles and larger at small zenith angles.

Equation 22 can be used in various ways to determine the LAI and also the $\chi$ for a canopy. The simplest application is that of Bonhomme et al. (1974). Since $K = 1$ for zenith angles near 57°, the inversion of Equation 22 is simple and gives:

$$\tau(\Theta) = \exp(-L)$$  \hspace{1cm} \text{Equation 24}

If a measurement is made when the zenith angle is about 57°, Equation 23 can be used directly to find $L$.

If measurements of the transmission coefficient, $\tau$, are made at several elevation angles, a simple method from Lang (1987) can be used. The measurements of $\tau$ are used to compute

$$y = \cos \Theta \ln(\tau)$$  \hspace{1cm} \text{Equation 25}

These are regressed on $\Theta$ (in radians), giving a slope ($B$) and intercept ($A$). LAI is given by:

$$L = 2(A + B)$$  \hspace{1cm} \text{Equation 26}

An approximate value for $\chi$ is

$$\chi = \exp(-B/0.4L)$$  \hspace{1cm} \text{Equation 27}

**EXAMPLE PROBLEM 3**

Readings were obtained as given in the following table:

<table>
<thead>
<tr>
<th>$\Theta$-deg</th>
<th>$\Theta$-rad</th>
<th>$r$</th>
<th>$-\cos \Theta \ln r$</th>
</tr>
</thead>
<tbody>
<tr>
<td>35</td>
<td>0.61</td>
<td>0.21</td>
<td>1.28</td>
</tr>
<tr>
<td>41</td>
<td>0.72</td>
<td>0.18</td>
<td>1.29</td>
</tr>
<tr>
<td>55</td>
<td>0.96</td>
<td>0.10</td>
<td>1.32</td>
</tr>
</tbody>
</table>

Linear regression gives the following values for each variable:

- $A = 1.21$
- $B = 0.12$
- $L = 2(1.21 + 0.12) = 2.64$
- $\chi = \exp(-0.12/0.4 \times 2.64) = 0.9$
This menu features eleven options:

- **Calibration**
  Calibration will begin the calibration process (Section 4.1). The external PAR sensor (Section 3.2.2) will be needed to complete calibration.

- **Location**
  The location must be set to the appropriate country, city, latitude, and longitude prior to use to make accurate LAI calculations (Figure 23; Section 2.1).
  North latitudes are designated positive and south latitudes are negative; east longitudes are positive and west longitudes negative.

- **Date**
  The date must be changed prior to use to record accurate information (Section 2.1). LP-80 uses the date provided to calculate $z$ and $F_b$ values. The date can also be changed in the LP-80 Utility.

- **Time**
  The time must be changed prior to use to record accurate information (Section 2.1).

- **Daylight Savings**
  Daylight savings must be toggled on or off prior to use to record accurate information (Section 2.1). LP-80 uses this parameter to calculate $z$ and $F_b$ values. When daylight savings is on, the time will automatically adjust.

- **Leaf Distribution**
  This selection adjusts the leaf distribution parameter for the plant canopy to be measured. Use **UP** and **DOWN** to change the value of the $\chi$ parameter. Press **ENTER** to save.

- **External Sensor Constant**
  This selection adjusts the calibration constant of the external sensor (Section 3.2.2). This should only be changed when using a new or recently recalibrated external sensor. The external sensor constant value should match the value on the external sensor cable tag. Use **UP** and **DOWN** to set the correct value, and press **ENTER** to save.

---

### 3.4.4 EXTINCTION COEFFICIENT AND CANOPY STRUCTURE

If the elements of a canopy are randomly distributed in space, then the probability of a ray of light, or other probe, penetrating the canopy without interception can be calculated from theory. The probability of penetration without interception is equal to the sunfleck fraction, which is the beam transmission coefficient, $\tau(\Theta)$, for the canopy. $\tau(\Theta)$ usually varies with zenith angle. The transmission coefficient for a canopy of randomly placed elements is:

$$\tau(\Theta) = \exp(-K(\Theta)L)$$

where $L$ is the LAI of the canopy (area of leaves per unit area of soil surface) and $K$ is the extinction coefficient for the canopy, which depends on the leaf angle distribution of canopy elements and the zenith angle of the probe.

A number of expressions have been proposed for $K$. The most useful is from Campbell (1986) where the angle distribution of canopy elements is assumed to be ellipsoidal. One can picture the angle distribution of area in a plant canopy to be similar to the angle distribution of area on the surface of oblate or prolate spheroids, or spheres. The equation for $K$ is:

$$K = \frac{\sqrt{\chi + 1}}{\chi + 1}$$

where $\chi$ is the ratio of the length of the horizontal to the vertical axis of the spheroid and can be measured as the ratio of the projected area of an average canopy element on a horizontal plane to its projection on a vertical plane. The extinction coefficient versus zenith angle is shown in Figure 27. See the Glossary for more discussion of $\chi$ and typical values for some canopies.
Equation 17
\[ L = \frac{\left(1 - \frac{1}{e} \right) \ln \left(1 - 0.47 f_b \right)}{\left(1 - 0.47 f_b \right) A} \]

The difference in accuracy of the two equations is smaller than other uncertainties in the method, so the LP-80 uses Equation 15 to determine LAI.

The LP-80 program utilizes these equations when the instrument is used to automatically calculate LAI. With the correct local time, date, and leaf distribution parameter, the LP-80 automatically calculates zenith angle and beam fraction. It then couples these parameters with collected intercepted PAR data to determine LAI.

This section describes the method of manually collecting PAR data for the determination of LAI in a barley and pea canopy.

EXAMPLE PROBLEM 1
PAR was measured at 391 μmol/(m²s) above a barley canopy on an overcast day. The average of several measurements below the canopy was 62 μmol/(m²s). The fraction of PAR transmitted by the canopy was therefore

\[ \tau = \frac{62}{391} = 0.159 \]

Since the day was overcast, \( f_b = 0 \) if \( a = 0.9 \), then \( A = 0.86 \) (Equation 16). Measurements on overcast days do not require assumptions about canopy structure (\( \chi \)) or zenith angle (\( z \)).

Using Equation 17 to solve for \( L \):

\[ L = \frac{62}{0.86} - 2.14 \]

EXAMPLE PROBLEM 2
PAR was measured at 1,614 μmol/(m²s) above a pea canopy and at 80 μmol/(m²s) below the canopy. The fraction of PAR transmitted by the canopy was therefore

\[ \tau = \frac{80}{1,614} = 0.05 \]

The zenith angle was 30°, and the \( f_b = 0.881 \). The \( A \) value (Equation 17) is again 0.86. \( z \) for the canopy is unknown, but unless leaves have obvious horizontal or vertical tendencies, a spherical distribution (or default distribution) can be assumed so \( z = 1.0 \).

Using \( z = 30^\circ \), solving for Equation 13 gives \( K = 0.577 \).

Substituting these values into Equation 17 results in

\[ L = 5.2 \]

Figure 24  Active segments screen

Use UP and DOWN to set the desired active segments. The icon on the right side of the screen will illustrate the active segments as the number is increased or decreased. Press ENTER to save.

If fewer than eight segments are active, the number of active segments will appear on the PAR and Log tabs.

NOTE: If a segment is deactivated, that segment data will record 0. Deactivated segment numbers will not be used in LAI calculation.

• Power Filter

A power noise filter value may be needed to eliminate noise from AC-powered light sources on sensor measurements. Highlight Power Filter: and use ENTER to toggle between either 60 Hz or 50 Hz.

NOTE: North American and Asian light sources use 60 Hz. Most European light sources use 50 Hz.

• Contrast

The Contrast screen controls the screen contrast (Figure 25). Use UP and DOWN to set the correct level. Press ENTER to save or ESC to cancel adjustments.

Figure 25  Contrast screen
3.3 LP-80 UTILITY

The LP-80 Utility is a program designed specifically for interfacing with the LP-80. This program can be used to download measurement data to a computer, erase LP-80 data, set the date and time, and see information about the LP-80.

Install the LP-80 using the included USB drive (inside the cover of the LP-80 Manual). The latest version of the LP-80 Utility can also be installed from https://meter.ly/lp-80-support.

1. Insert the USB into the USB port.
2. Open the USB drive named METER Group, Inc.
3. Move the LP-80 Utility application onto the computer’s hard drive.

The four menus across the top of the screen change program and LP-80 settings. Below is a brief overview of the options each menu contains.

**FILE MENU**
- Download Data: Saves measurement data stored in the LP-80 as a data file on the computer (Section 2.5).
- Erase Data: Erases all data in LP-80 (Section 2.6).
- Exit: Quits the program.

**EDIT MENU**
- Preferences: Opens the Preferences window. The Preferences window has three tabs: Data File, Communications, and Application tab.
Assume only $T$ needs to be done and $S$ needs to be measured above the crop canopy. Level the LP-80 above the canopy and press UP. The reading displayed in the upper right portion of the screen is the value for $S$.

Measure $T$ by placing the LP-80 below the plant canopy. Carefully place it below all of the leaves and keep the instrument level. Press DOWN. The resulting values are displayed below the above-canopy values on the screen. Since the light below the canopy is extremely variable, several samples at different locations will be necessary for a reliable reading. The number of necessary samples can be determined by taking, for example, ten individual readings and computing the coefficient of variation ($CV$) with Equation 9.

$$CV = \frac{s}{T}$$  \hspace{1cm} \text{Equation 9}

where $s$ is the standard deviation of the 10 readings: $s = \sqrt{\frac{\sum (T_i - \bar{T})^2}{n-1}}$  \hspace{1cm} \text{Equation 10}

where $n$ is the number of samples taken. The fractional error in the measurement of $T$ will be $CV$ divided by the square root of the number of samples.

After the first below-canopy PAR measurement, the current $T$ value will be displayed in the lower left corner of the screen. With each subsequent below-canopy measurement, the $T$ value will be updated. After sufficient measurements, use the displayed $T$ value in the lower left corner for $T$ (Equation 6).

To find $r$ (Equation 7), level the LP-80 above the canopy and press UP. Then invert the LP-80 at a height of 1 or 2 m above the crop canopy. Leveling is not critical for this measurement since the radiation reaching the sensor is not directional. Press DOWN in the PAR sampling tab. Multiple readings are typically not necessary, since $r$ is not usually variable. Equation 7 shows $r$ in the $T$ location at the bottom of the LP-80 screen.

To find $r_s$, invert the LP-80 over the soil below the canopy and take measurements at several locations. Average and store these measurements as before. This reading is the value $r_s$. Calculate $r_s$ from Equation 8 using $T$ and $r$. A value in the range of 0.1 to 0.2 should be obtained, but it is possible that the light level below the canopy will be so low that $r$ will not be accurately measured. If a value outside of the expected range is obtained, there will be negligible error in $r_s$ by assuming $r = 0.15$. As mentioned before, evaluation of intercepted radiation normally involves the measurement of $r$.

Only measurements below the canopy have been discussed. Obviously, measurements throughout the canopy are possible. Profiles of interception with height can be useful in determining at what location most of the photosynthesis occurs in the canopy.

The Data File tab is used to change column headers and the date/time format.

- Column headers checkbox includes column headers for saved data files (Section 2.5). This feature is on by default.
- Date/Time Format sets how the date and time are displayed in saved data files. By default, the program will use Windows Regional and Language Options (the system settings accessible in the Windows Control Panel).

The Communications tab is to change settings in communicating with the LP-80. These should only need to be changed if troubleshooting a connection issue.

- Command Retries: Set the number of times the computer should automatically try sending communications commands (up to 10).
- Maximum Baud Rate: Set the maximum baud rate for talking to the LP-80.
- Command Retries: Set the number of times the computer should automatically try sending communications commands (up to 10).

The Application tab sets application preferences.

- Automatic Internet Version Check: Select to automatically check for updates for the LP-80 Utility when connected to the internet. Updates can be manually searched for in the Help menu.
- Automatic Clock Synchronization: Sets the LP-80 time to the computer time automatically, when connected.
- Error Log File: Adds additional details to error log files, which can be sent to METER for troubleshooting.

The Application tab sets application preferences.

- Set Date/Time: Synchronizes the LP-80 date and time to the computer date and time.
- View Information: Displays the serial number, firmware version, firmware checksum status, battery level, number of stored readings in the LP-80, and current date and time.

The Application tab sets application preferences.

- About LP-80 Utility: Displays the current program version.

Occasionally, METER releases firmware updates for the LP-80 to improve the performance of the instrument. These updates can be found through the LP-80 Utility Help Menu. Do not turn off or disconnect the instrument from the communication port while the firmware is updating.

NOTE: Any data records on the instrument will be erased during a firmware update. Download data before loading new firmware.
To update the firmware, use the following steps:
1. Connect the LP-80 to an available communication port.
3. Click Run.
   If the application does not automatically ask, open the firmware updater application from the Downloads menu. A warning will appear to download all saved data.
4. Click OK.
   The LP-80 Firmware Updater window should appear.
5. Select the correct communication port in the dropdown list.
6. Click Start.
7. When the firmware updater is finished, close the application.

3.4 THEORY
The LP-80 is useful for a number of applications, including the measurement of average and intercepted PAR. PAR is the radiation in the 400- to 700-nm waveband. It represents the portion of the solar spectrum that plants use for photosynthesis. Under a plant canopy, radiation levels can vary from full sun to deep shade over the space of a few centimeters. Therefore, reliable measurement of PAR requires many samples at different locations under the canopy. The LP-80 calculates LAI and other attributes of the canopy structure with these measurements.

3.4.1 AVERAGE AND INTERCEPTED PAR
Monteith (1977) observed that dry matter production of a plant canopy is directly related to the amount of photosynthetically useful radiation intercepted by the canopy. Dry matter production \( P \) is modeled as the product of three terms:

\[
P = e f S
\]

where \( e \) is a conversion efficiency, \( f \) is the fraction of incident radiation intercepted by the crop, and \( S \) is the flux density of incident radiation intercepted by the crop. Conversion efficiency \( e \) and fractional interception \( f \) are determined by crop physiology and management.

Incident solar radiation is the only environmental factor. If \( f \) and \( S \) are monitored over the period of crop growth and \( P \) is measured at harvest, \( e \) can be determined. The results of experimental treatments or the influence of genetics can be interpreted in terms of their effect on \( e \) and \( f \).

The incident radiation on a canopy can be (1) absorbed by the canopy, (2) transmitted through the canopy and absorbed or reflected at the soil surface, or (3) reflected by the canopy. In principle, only PAR absorbed by the canopy is useful in producing dry matter, so it should be the fractional absorption. Equation 1 delineates the parameters needed to calculate \( f \):

\[
f = 1 - t - r - r_s
\]

where \( t \) is the fraction of incident radiation transmitted by the canopy, \( r \) is the fraction of incident radiation reflected to a sensor above the canopy, and \( r_s \) is the reflectance of the soil surface.

The last two terms are often ignored, so approximate fractional interception is

\[
f \approx 1 - t
\]

The error resulting from this approximation is usually small when \( t, r, \) and \( r_s \) are measured. The error becomes much more significant when measurements of total solar radiation are used because of large scattering coefficients of leaves for near-infrared radiation.

As a first-order estimate of error, assume that

\[
r = (1 - t) r_c + r_s
\]

Then becomes

\[
f = (1 - t)(1 - r_c)
\]

The error resulting from using approximate fractional interception is approximately equal to \( r_c \), which is typically \( \leq 0.05 \) in the PAR waveband. Since the LP-80 sensors are sensitive only to radiation in the PAR waveband, Equation 3 will be fairly accurate for making measurements of intercepted radiation. However, measurement of the other terms needed for Equation 2 is simple and is dealt with later.

3.4.2 SAMPLING FOR FRACTIONAL INTERCEPTION
The functions needed to perform these calculations are available in the PAR sampling tab of the LP-80. The measurements needed for fractional interception are those from which \( t, r, \) and \( r_s \) are calculated. If \( T \) is the PAR reading from an upward-facing LP-80 above the plant canopy, \( R \) is the reflected PAR above the plant canopy (inverted LP-80 above the crop), \( T \) is the upward-facing LP-80 below the plant canopy, and \( U \) is the reflected PAR from the soil surface, then \( t, r, \) and \( r_s \) can be calculated with Equation 6 through Equation 8.

\[
t = T/S
\]

\[
r = R/S
\]

\[
r_s = U/T
\]